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Campus-wide E-mail
and Internet Access

Donald Riley, Professor, Associate Vice President
and Associate Provost Academic Affairs

It Began in 1992

The campus-wide E-mail and
Internet access project was
introduced in the fall
of 1992. This
project provides
/\ free electronic
k' / mail and Internet
/\\ access for all
~ /// faculty, staff and'
/ students at the Univer-
/ sity of Minnesota Twin
Cities campus.
When we introduced this project, we also initiated dial-up SLIP
access; thereby providing for network connections from off-

campus telephones, such as home and dormitory, with an initial
pool of 32 modems.

Explosive Growth

Since that time, we have experienced explosive growth in the use
of these facilities. On the central E-mail machines, “maroon”
and “gold,” we are now delivering 800,000 messages per week
with a growth rate of around 5-10 percent per week. The dial-up
SLIP access has been experiencing similar growth of around 20
percent per month. On a typical day, users make between
12,000 to 15,000 SLIP connections.
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Best wishes in the New Year

As of this writing the SLIP modem pool stands at 400
modems; by the time you read this it should have about
600 modems.

This kind of growth has been difficult to accommodate,
both from a financial and human resources standpoint,
given University budgets of recent years.

Lost Funding

The University’s supplemental budget request last year,
vetoed by Governor Carlson, included funds for expanding
the E-mail systems and increasing the number of modems
in the SLIP modem pool. Enhancements and expansion
have occurred through reallocation of funds and staff from
other projects, but it has not been easy. The loss of the
vetoed funds forced us to develop alternative, less expen-
sive plans for enhancing the E-mail system and delayed the
implementation schedule until right around the start of
classes this fall.

The timing was of major concern to Computer and
Information Services’ staff. Since projected growth rates in
use of E-mail indicated that the E-mail system would not
be able to handle the expected fall load, the decision was
made to go ahead with the acquisition and installation of
the Sun Microsystems multiprocessor units.

Temporary Slowdown

Unfortunately, we immediately hit an undocumented
problem in the software supplied by Sun Microsystems,
which only appears when you try to handle more than 125-
130 simultaneous interactive users. It took over a month
— working closely with Sun software engineers — to find
and correct the series of problems associated with this
phenomenon. During this time period, users experienced
E-mail delivery delays of up to 12 hours. However, even
during this difficult period, the volume of E-mail delivered
was significantly higher than last year at this time (as shown
in the Busy Signals article in our December issue).

We believe we are past these difficulties, and we are
delivering E-mail at record levels of approximately 800,000
messages per week. During the peak busy period, which
occurs around 3:00 p.m. each day, the maximum delay
time for mail to be delivered through the “maroon” and
“gold” mail systems is no more than 30 minutes.

Expanding the SLIP Modem Pool

To accommodate the growth in demand for dial-up
services, we are expanding the SLIP modem pool by an
additional 200 modems. Here again, in our planning we
encountered a dilemma., We knew we needed to add
additional modems, and newer, faster modems were
supposed to be on the market this summer. We had hoped
to add more modems by the fall; however, delivery sched-
ules of the modem vendors and subsequently the terminal
server vendors were delayed. Given the limited resources
available to invest in the modem pool, we thought it
prudent to delay until we could install the newer, faster
modems, rather than going with the older technology.

We have been testing the newer terminal servers and plan
to have the new modems and servers in place around the
first of the year.

What’s Next?

What next? Up to this point, the E-mail and Internet
access as well as the dial-up SLIP access has becn a free
service to all faculty, staff and students. Because of the
problems of keeping up with the explosive growth in use of
these services on extremely limited budgets, we have been
engaged in analyzing usage patterns. Based on this
analysis, we have concluded that a very small percentage of
the users consume a very large percentage of the available
resources. We are considering the possibility of providing
some base level of free access to faculty, staff and students,
but also implementing some kind of fe¢-for-service for
those users who consume significantly more of the re-
sources.

Another option is to add dedicated modems for particular
users or departments and charge for this special service. At
the present time, adding sufficient modems to address the
access problem would be too costly; and tariffs are cur-
rently too high to make ISDN or leased 56k lines a viable
choice.

We have been striving to provide a high quality, reliable
service to University faculty, staff and students either free
or at as low a cost as possible. While limited University
resources have made this difficult, we remain committed to
this objective and will continue to work hard to achieve it.
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Floppy Minuet

Using a floppy disk to access E-mail

You may want to use Minuet on a
floppy disk if you need to be able
to carry your E-mail messages
with you wherever you go
throughout the day.

When you use Minuet
on a floppy disk you
can read and compose
E-mail messages
using any IBM
compatible computer
anywhere; even if the
computer does not
have a network
connection. In
addition, you can use your “Floppy Minuet” disk to fetch
and send E-mail from any Computer Facility — or from
home via SLIP dial-up access to the campus network.

Create a Minuet Floppy Disk
We recommend that you use a high density 3 1/2-inch
disk. Format your disk and copy the following Minuet
files:

MINUET.EXE

MINUET.CNF

CUSTOM. TXT

MINUET.HLP

These files are located on micro_info, our IBM Information
(Novell) server. The easiest way to copy them is to take a
floppy disk to:

¢ any Microcomputer HelpLine

e students can go to any Computer Facility

(a list is at the end of this article)

Remember to format your disk first. Then go to the P;
drive. A batch file named

flopmin.bat

Figure 1: Fill in these Minuet Fields

E-mail Address
Your full name

1ily1010@gold.tc.umn.edu
Jasmine R. Lily

will copy the four Minuet files to the drive you specify.
For example, at the P:\> prompt type:

flopmin a:

After the files have copied, you will have about 778K of
extra space for messages and files. Minuet creates all the
other files and directories as needed.

Start Minuet

By the time you read this the Computer Facilities on all
campuses should let you access Minuet on a floppy disk.

East Bank or St. Paul

After you start up one of the IBM-compatibles, you will be
presented with a C:\> prompt. (If you are given an option,
select the DOS prompt.) To start your copy of Minuet, at
the C:\> prompt type:

a:minuet

Press the key and wait for Minuet to load. You will
see the Incoming mail window.

West Bank (HHH 50)
When you start an IBM computer in HHH 50, you are
presented with a Novell Menu System with a list of selec-
tions. When you select

1. Floppy Minuet

a message will remind you to insert your Minuet floppy
disk in drive A. Once you press (Return), Minuet will load
from your floppy disk.

Set up Minuet

The first time you start Minuet, you will want to set it up
for your E-mail account. From the Setup menu choose
User and you will see a “Setup Personal Information”
dialog box. Fill in the two fields shown in Figure 1.

You must enter your complete E-mail address; in the
example in Figure 1 that address is:
lily1010@gold.tc.umn.edu. If you wish, you can also enter
your full name. Leave the other fields blank.
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Click OK or Press
To tell Minuet you have completed filling out a dialog box,

click OK or press the (At }{K) keys.

Password Security

To ensure the security of your account, do not enter your
password in the Setup dialog box. Minuet will automati-
cally prompt you for your password when it is needed to
access the network. If you misplace your disk or someone
else tries to use it, they will not be able to access your
account without entering your password.

Additional Setup Menu Choices

Automate Your Mailings

A. Sclect Preferences. Check Add signature to outgoing
mail so that your signature is automatically appended
to every outgoing message. You may want to check
Save copy of outgoing mail to keep a record of messages
you send.

Create Signature

B. Select Signature to enter your signature. A polite
signature would be short but include your name, E-
mail address, and institutional affiliation, such as:

Jasmine Lily, lily1010@gold.tc.umn.edu
University of Minnesota, Plant Biology

Create an “Address” Book

C. Select Aliases to enter a list of E-mail addresses of
people and groups. For example, you may send E-mail
frequently to your friend in Ecuador, your cousin
Wanda Fish, and your garden club.

An alias is a meaningful name followed by a blank
space and one or more E-mail addresses, as shown in
Figure 2.

Fetch Your Mail

You can use any IBM-compatible in one of the Computer
Facilities; all of them are connected to the campus net-
work. To fetch new mail you should be in the

Incoming mail

window. Press or click the Fetch command to begin
transferring the mail from the mail server to your floppy
disk. If your password is needed, Minuet will prompt you
for it.

All fetched mail messages are automatically saved to the
directory:

A:\INBOX.MBX

Enclosures
Any enclosures you receive are saved to the directory

A:\ENCL

In order to read an enclosure, you will need the application
which created it, such as Microsoft Word or WordPerfect.

Reading and Composing E-mail

You do not need to be connected to the network to read
or compose E-mail messages. You can compose as many
messages, replies, and forwards as you like. Your only limit
is disk space.

You can start Minuet on any IBM-compatible that can read
your disk.

0 Read messages in the Incoming mail window. If
necessary, select the Window/Viewer command to sce
it. Press or to go to next and previous

messages.

0 To compose a new message, go to a Composer
window. If appropriate press for Composer; the
exact command you use depends on which Minuet
window you start from.

Fill in the information for recipient, subject line, and
message “fields.” If you have set up aliases, remember
to use the Alias command to designate recipient(s).

Figure 2: Sample Alias List

Juan jrivera@pi.geo.ec

trevor tplant@bcfreent.neflin.lib.fl.us

garden_club rose@thorn.com tigerl23@maroon.tc.umn.edu

asmyth@flowers.org
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O Each time you want to begin a new message, press
to open a new Composer window; press to go
back to a previous message.

You can return to any message to edit it. Minuet saves
all your messages until you can send them. A status
message at the bottom of the Composer window tells
you which message you are composing, for example:

Composer 5 of 5

Sending Messages

To send your messages, you must connect to the network.
Start Minuet as usual and select Window/Composer.

Send One Message
To send a single message, display the message you want to
send and press the key or click Send.

Send All Composed Messages
To send all the messages you have composed, hold down

the key and press the key, or hold the key
and click the Send command.

Quit Minuet
Always quit Minuet before you ¢ject your disk! From the
keyboard press (At }(x}; or click Exit from the File menu.

Disk Full

Eventually, your disk may fill up. For many people, the
easiest solution is to start a new Minuet floppy disk. If you
like, you can skip the on-line help file, MINUET.HLP,
and save 121K. However you will notice additional files
that Minuet created when you set up your signature,
aliases, etc. If you want to continue to use the information
in these files, copy the files listed here to your floppy disk:

POPMAIL.GUP
MINUET.SIG
MINHIST.TXT

Do not copy any of the directories.

More Information
To use Minuet’s on-line help, click on the command or
field where you want help, then press (F1_).

A short Minuet Quick Reference Guide is also available. It
covers the basics and lists the commands by function key.
You can pick up a copy at any Microcomputer HelpLine.
Or, if you are on-line, you can get the text file guickref.txt
by anonymous ftp from boombox.micro.umn.edu.

Using Minuet/FTP
From Minuet’s menu select the Window/FIP command
and enter the server name

boombox .micro.umn.edu

Minuet assumes you want to use anonymous ftp, so click
OK when you see the dialog box with the word anony-
mous. Then follow this path:

pub/pc/minuet/quikref . txt

To retrieve the file, press for “Fetch File.” Once you
have retrieved the file you can view it by using Minuet’s
File/Open command.

If you have questions about using Minuet, you can call the

E-mail HelpLine or, send E-mail to
minuet@boombox.micro.umn.edu.

Computer Facllities for Floppy Minuet

Building Room
East Bank

Lind Hall 26

Folwell Hall 14

Walter Library 9

Eddy Hall Annhex 54
St Paul

Central Library BSO

coB 135

McNeal Hall 305
West Bank

HHH Center 50
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URL-aware Software for the Mac

We’ve recently released
URL-aware versions of
TurboGopher and
POPmail. You’ll
find brief announce-
ments for both
products below as well
as some information on
URLs and helper applica-
tions that understand URLs.

V¥ Uniform Resource Locator

URLs can make locating resources on the Internet rela-
tively easy. U-R-L stands for Uniform Resource Locator.
URLs are an increasingly popular naming scheme that
includes the location and method of obtaining items or
directories on the Internet. The methods of obtaining
Internet resources include gopher, http (www), news
(newsgroups), mailto (E-mail), ftp, and telnet.

A Standard Form of URLs

Recently a working group of the Internet Engineering
Task Force (IETF) produced a document (rfc 1738)
defining a standard form for URLs. Given a standard way
to point to resources on the Internet, a next step is to
animate the URLSs that get embedded inside documents.
Animating the URL is desirable because a drawback to
URLSs is that they tend to be long and composed of
curious and mysterious garbage words, as shown in '
Figure 1 (some of these examples are from the “On-Line
Dictionary of Computing,” copyright Denis Howe, 1994).

As you can see, URLs are crammed with information.
Included in the URL is the name of the access scheme you
need to use to view or acquire the information. That word
is followed by a colon, for example:

ftp:
http:
gopher:

The parts that follow the colon vary. Generally two slashes
(//) precede a host (or port) name.

Embedded URLs

Instead of retyping the URL, you want to give a command
that says: go getit. To animate an embedded URL, the
software must automatically establish a link with the
document or directory. Next the client software that can
display, print, or save the item must be launched. To
execute these requirements the software must know several
protocols. Protocols are the rules used to define, distin-
guish, and transmit data.

V¥ Helper Applications

Since old Internet protocols evolve and new ones get
introduced, adequately supporting all protocols in one
application imposes horrific overhead on the development
of software. Rather than trying to do everything in a single
bloated application, several Macintosh developers (named
below) banded together to develop a modular approach.
They worked on a way to let software call external, helper
applications that “speak” the correct protocol. Their
cfforts resulted in a suite of network access components.

Mac network applications can use the AppleEvent suit this
team developed to do two things: call other applications
and fetch resources pointed to by IETFE-standard URLs.
This approach makes it easy to add URL support to most
Macintosh applications since the software can simply call
appropriate helper applications to handle the URL.

The Mac developers of this suite include:

Internet Gopher team TurboGopher, POPmail
(University of Minnesota) and InternetLink

Peter Lewis Anarchie

John Norstad Ph, NewsWatcher

Steve Dorner Eudora

John Hardin MacWeb

Figure 1: Sample URLs

ftp://wuarchive.wustl.edu/mirrors/msdos/graphics/gifkit.zip
http://info.cern.ch:80/default .html#Introduction

<URL:ftp://ietf.cnri.reston.va.us//internet-drafts/draft-ietf-uri-url-08.txt>
<URL :GOPHER: //wombat .doc.ic.ac.uk:70/77m/Dictionary>
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We’re very pleased with this approach. Ultimately this sort
of architecture allows developers to concentrate on doing
one thing really well and gives end users more choice in the
tools they use for Internet access.

Thread Manager

These kinds of software upgrades come with a price: they
don’t work with old system software. To take advantage of
these new features you need the Thread Manager extension
installed on your Mac. The Thread Manager works on all
Macs running System 7 or later. A thread is simply a series
of instructions executed in a program, and the Thread
Manager is a tool that manages these threads in
multitasking endeavors.

If you are running System 7.5, the Thread Manager is
already installed on your Mac. On pre-7.5 systems you
must drop the Thread Manager into your System folder
and restart your Mac. A copy of the Thread Manager is
included with TurboGopher.

Mode 32 Conflict
Thread Manager conflicts with Mode32, software that
some old Macs using System 7 have installed.

Why use Mode32? Once Mode32 and System 7 are
installed, those who use a Mac II can access up to 72MB of
RAM and users of Mac IIx, IIcx, and SE /30 systems can
access up to 128MB of RAM. Mode32 is of no use to 16-
bit Macs, that is, the Plus, SE, Classic, and Portable.
Mode32 is not needed for the newer Macs.

V¥ POPmail 2.2b2

We’ve made one significant change to POPmail (electronic
mail client software): version 2.2b2 includes support for
resolving URLs that are embedded in E-mail messages.
This change makes E-mail messages seem like Internet-
aware hypertext.

Fetch that URL

Now when your friends, colleagues, or mailing list group
write to you about some wonderful Internet resource, if
they use the URL reference, you can use the Mai/ menu’s

Resolve URL
command to check out the resource. To make this option

work, you must first highlight the URL (by dragging your
mouse through it).

To actually fetch an item pointed at by a URL, POPmail
calls the appropriate helper application. If you do not have
a cooperating helper application on your hard disk,
POPmail will not be able to complete your request.

Painless Upgrade

The upgrade is painless. When you copy the software to
your disk you do not lose the options you’ve selected from
the Setup menu, any messages you’ve saved or archived, or
any groups you’ve created.

V TurboGopher 2.0b5

Version 2 of TurboGopher marks the start of our move
toward a component architecture for Internet access tools;
it works with all versions of System 7.

TurboGopher is still the fastest Macintosh Gopher client
software available. Version 2 runs in native mode on
Power Macs and on other Macs running System 7. This
turbocharged version lets you read the first part of a
document or directory while the rest is being fetched. You
can fetch multiple documents or directories at the same
time and view documents larger than 32K without first
saving the document to disk — providing you have enough
memory in your system.

Updated On-Line Help

Although you can learn a lot about TurboGopher’s new
features just by reading the built-in help, we’ll cover a few
topics to get you started. You’ll find the Help item under
the Gopher menu. Once you’ve opened a Help window,
you can use the Edit menu’s Find command to search for
specific topics.

The first time you start TurboGopher version 2, it opens
the Help window. If you close that Help window, it will
ask:

Do you want to save the changes to
“TurboGopher Help”?

We strongly suggest you answer “Yes.” The documenta-
tion answers common questions and also has an advanced
features and shortcuts section; this section contains infor-
mation on features that most longtime users eventually
want to master,

§
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Bookmarks

Gopher bookmarks serve the same function as paper
bookmarks. Both make it easy to return to selections you
want to peruse again. There is one major difference
between paper bookmarks and Gopher bookmarks. Paper
bookmarks are static. Gopher bookmarks save a pointer to
the networked item. The actual item stays on another
computer (the Gopher server). Since this pointer simply
acts as a link to a point in Gopherspace, the contents of the
referenced item may change when you link to it the next
tme.

The bookmark feature of TurboGopher version 2 has been
improved. One improvement is that you can now use
standard Macintosh Cut-Copy-Paste commands to build or
rearrange your list of bookmarks.

Accessing Old Bookmarks

Version 2 has a different implementation of the bookmark
feature. A by-product of this change is that version 2 does
not recognize unconverted version 1 bookmark files.
Although preparing for this conversion requires extra steps
on your part, the process is casy.

Create a Separate Bookmark File

Many versions of TurboGopher let you save bookmarks
you’ve accumulated to a separate file. This feature also lets
you make a backup of your bookmarks; the cautious will
already have made a backup of their valuable bookmark
collection. If you do not have a current backup, you must
create one before you can open your bookmark file in
TurboGopher version 2.

Version 1

Save as Bookmark File

Start up TurboGopher version 1. If the Bookmarks
window is not open, select the Show Bookmarks option
from the Gopher menu. Next, sclect the Save as Bookmark
File option from the File menu. If you save the backup to
your desktop, it will be very easy to find when you import
the “old” bookmarks into TurboGopher version 2. When
you’re done; use the Qust command.

Version 2

plus Open Command

Start up TurboGopher version 2. Hold down the
key while selecting Open from the File menu. You may
need to navigate disks and folders to find the old book-
mark file; or you may find it on your desktop, as we
suggested carlier. Once you’ve located and opened the old
bookmark file, it will be converted to the new, version 2,
format.

Hereafter whenever you want to open this bookmark file,
you can simply select Open from the File menu.

Cut-Copy-Paste
Version 2 comes with some preset bookmarks; they’re
listed in the window called

Bookmark Worksheet

You can customize this worksheet; it’s like a general
construction area. When you paste items into it that you
either copied while visiting some Gopher location or cut
from another bookmark file, the worksheet’s revised
contents are automatically saved in a file called “Bookmark
Worksheet.” If you close the Bookmark Worksheet
window and want to open it again, select Show Bookmark
Worksheet from the Gopher menu.

Customizing the Bookmark Worksheet

You can rename a bookmark entry. To do this select the
entry’s name, then select Edit Gopher Descriptor from the
Gopher menu. From the resulting window you can edit the
Title that shows up in your bookmark worksheet. Don’t
use this edit option to change anything else unless you
understand the Gopher protocol.

You can use the standard Cut-Copy-Paste commands to
rearrange items in any window. This feature lets you put
the items you use most frequently at the top of the list or
arrange the entries in any way that makes sense to you.

Bookmark Overload

Many people accumulate so many bookmarks they find it
difficult to manage the resulting list. Two options might
help you if you, too, are experiencing bookmark overload.
You can use the File menu’s

New Item List

command to start a separate bookmark list devoted, for
example, to governmental gophers. Thereafter when you
want to open this bookmark file, select Open from the File
menu.

In addition, if you find a folder somewhere in Gopherspace
that you would like to come back to later, you can use the
Save As command to save the entire folder to your hard
disk.
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Fetch that URL

You’ll find the Use Uniform Locator option in the Gopher
menu. You can type or paste a URL into this option’s text
window; and when you click on the OK button,
TurboGopher will attempt to access the document or
directory. To complete your request, if necessary,
TurboGopher will call the appropriate helper application,
such as ftp (Anarchie). Of course, if you do not have a
cooperating helper application, TurboGopher cannot
complete your request.

Preferences Menu

If you access a lot of ASCII (plain) formatted text, you may
want to change the font that is used to display information
to a fixed width font, such as Courier. You can do this
with the Gopher menu’s Preferences options.

With version 1, whenever you downloaded something you
had to tell TurboGopher where to save the item. Version
2 lets you select a default location to download items; to
customize this option look in the Preferences menu.

V¥ Obtaining the Upgrades

Both the TurboGopher and POPmail upgrades are avail-
able on Gopher and on the Mac Information Server. An
extensive collection of helper applications are also conve-
niently available on Gopher.

via Gopher

The POPmail and TurboGopher upgrades are available via
gopher and anonymous ftp from
boombox.micro.umn.edu. You can download self-
extracting archive versions of the software. Many people
already have bookmarks called TurboGopher Distribution
and POPmail Distribution. They can use these bookmarks
to zoom to the appropriate section of Gopherspace.

If you don’t have the bookmarks, the full Gopher path is
Information About Gopher
Gopher Software Distribution
Macintosh TurboGopher

The POPmail upgrade is in the section called

helper-applications

This section makes it easy to obtain the helper applications
you need to access and “animate” the resources you can
find on the Internet.

The URLs for the two upgrades are shown in Figure 2.

via Information Server

You’ll also find the POPmail and TurboGopher upgrades
on the Information volume of the Mac Information Server.
In the near future we’ll be rearranging folders on this
server; our goal is to make it easier for you to find things.
For now, you’ll find a POPmail folder inside the Network
Software folder. You’ll also find a Gopher folder inside the
Internet Tools folder. Here are both paths:

Information
Communications
Network Software
POPmail II
Internet Tools
Gopher Programs

Obtaining Helper Applications
When you upgrade you’ll probably also want to get some
helper applications.

Although version 2 of TurboGopher still functions as a
stand-alone gopher client, it can now be called by other
applications that want to resolve a Gopher URL. Likewise
TurboGopher calls other applications to resolve URLs —
provided the software is available on your hard disk. At
press time those programs were Anarchie (ftp),
NewsWatcher (newgroups), and MacWeb (WWW /html).

The Helper Applications section also includes other
software. Internet explorers frequently find that they need
many companion programs to make use of the resources
they find on the Internet. The Helper Applications section
contains a variety of software that meets this wide defini-
tion of helper.

To use some of the applications you must install them in
your System folder or do other things to set them up.
Read the accompanying “readme” files or look for further

Figure 2: URLs for the Upgrades

GOPHER: / /boombox.micro.umn.edu:70/11/POPmail /macintosh
FTP://boombox.micro.umn.edu//pub/POPmail/macintosh/
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instruction in the software’s built-in help files for specific
instructions.

Over time the software included in the Helper Applications
section will change. Below are brief descriptions of some
of the helper software.

Internet Clients

Anarchie

Anarchie is shareware and an ftp and Archie client. Like
Fetch it will let you browse fitp sites, download files, or find
them using an Archie server.

MacWeb
MacWeb is World Wide Web (WWW) client software,
similar to Mosaic.

Ph1
Ph client for use with the UIUC CSO nameserver (elec-
tronic phonebook software).

NewsWatcher
NewsWatcher is news readers software.

Internetlink

InternetLink is our Acrobat Exchange plug-in. It adds
URL support to PDF files. Currently URL support is not
available for the free Acrobat Reader software.

Image and Sound Utilities

Acrobat Reader

Adobe’s Acrobat Reader software is now free. It lets you
view, navigate, print, and present any PDF (Portable
Document Format) file. PDF files are created by other
Acrobat software, such as Acrobat Exchange, Acrobat
Distiller, and Acrobat for Workgroups. The reader soft-
ware lets people access documents without having the
application software, such as PageMaker or Microsoft
Word. Acrobat Reader is especially useful for reading
newsletters, journals, and other precisely formatted publi-
cations on your computer screen.

JPEGView

JPEGView is an image viewer for PowerPC Macs and
680x0 Macs. It can open and display images in JPEG,
PICT, GIF, TIFF, BMP, MacPaint, and Startup Screen
formats.

QuickTime

Apple’s QuickTime system software extension adds
capabilities that let your applications integrate graphics,
sound, video, and animation into documents.

Simple Player
Simple_Player uses the QuickTime movie controller to play
and edit movies.

SoundMachine
A ulaw (or mu-law) sound player.

Sparkle
Sparkle is freeware that plays MPEGs, PICTs, and
QuickTime movies and converts between them.

Ulaw
ULaw converts Mac sampled sounds to Sun Ulaw format
sounds and vice versa.

File Utilities

CompactPro

A shareware file compression utility that supports archives
and self-extracting archives.

StuffitExpander
Freeware to expand compressed files.

Downline

DownlLine is a utility which lets you process multiple files
in predefined ways. DownLine can un-Stuff, un-Binhex,
un-Packit, Stuff, and Binhex files in batch mode or on
demand. This demo release is free.

UULite

UULite is shareware that handles UNIX to Mac text and
Mac text to UNIX text conversions, that is uuencode and
uudecode.

-
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Academic Index
A Good Place to Start Your Research

Nancy K. Herther, University Libraries

Where would you go to look for
information on diverse topics such
as those shown below? The Univer-
sity Libraries now have a good all-
round starting point for whatever
research or trivia-types of questions
that you might have.

What are the current immigration patterns to the U.S. from
Europe?

What will be the impact of the Republican electoral victories
on the next Congress?

What trends will be affecting academic research universities
in the next decade?

Are cholesterol levels affected by vitamin intake?

What are today’s hottest high technology stocks?

Academic Index

Academic Index offers a good, international collection of
about 1500 scholarly, business and professional journals
for interdisciplinary research spanning the general sciences,
humanities and the social sciences. Topics covered include
health, economics, communications, public affairs, man-
agement, law, politics, education, ethics and the environ-
ment. The database is produced by Information Access
Company, a commercial, California-based database
company.

Our implementation of the database is updated monthly
and contains articles going back to 1985.

How Do | Get Access?

You can use the database from any public access LUMINA
terminal in any of our campus libraries. You can also have
remote access if you have an active Maroon or Gold E-mail

account and password. Once you are at the main
LUMINA screen, type in

indexes
instead of MNCAT or one of the other options. If you are

at a remote terminal, you will be asked for your user id and
your password, to verify that you entitled to use the

database, as defined by the terms of our contract. To use
Academic Index, select the multidisciplinary option or, to
get right into the database, type in

acad

Help and Tutorial

The database is menu-driven and quite easy to use. If you
have difficulty at any step in the process, type in either H
or T to access cither the Help screens or the useful Tutorial
to learn more about using the database.

Search Options

You can search by keyword — which will search through
the text of the citation (title, descriptors, abstract), or by
author, title or subject descriptor. For example, to search
for articles by management guru C. K. Prahalad, type in

prahalad-c-k

or simply type in prahalad, since this is an uncommon
name. You are then able to see the results of the search —
in this case eight articles with Prof. H. Prahalad as either
first or second author — and you can type in

QD

to get a quick display of the eight articles and an indication
of whether or not full-text is available.

Interested in covering some of the hot political issues of
the day? Let’s try prayer in public schools. By typing in

school? and prayer

at the search prompt you are given a total of 136 docu-
ments with these words in them. The question mark (?) is
used as a wild card to allow for truncation. The first
document in this list is shown in Figure 1. If the full text is
available for this article, to get it to appear on the screen
just type in

FT

Other important search options are given in Figure 2.

i
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Figure 1: Sample record in Academic Index “ACAD”

Document Display

DATABASE-ACAD

Geog. Location:

Search 1 SCHOOL? AND PRAYER 136 Documents

Document: 1

Accession No: 15522941. 9407.

Database: ACAD

Source: Church-State. volume 47, issue n5, May, 1994, p.12(2). (940500).

Coden/ISSN: ISSN: 0009-6334

Year: 1994

Title: School prayer crusade advances in Georgia, Mississippi. (school prayer bill adopted in Georgia
and Mississippi).

Georgia. Mississippi. NNUSUGA. NNUSUMS.

Religion-and-state: Analysis. Georgia: Religion. Mississippi: Religion.

ABSTRACT: Legislatures in states such as Mississippi and Georgia have adopted the school prayer
bills which are expected to be adopted in Washington D.C. and Florida as well. The bills allow
non-proselytizing and non-sectarian prayers at public school events. The prayer will be led by a
student volunteer. Various civil liberties groups, including Americans United in Washington DC,

Descriptors:
Abstract:

are against such a bill.
Illustration: cartoon.

To skip to a screen, enter screen number.

Screen — __

S-Search RD-Resume Display FT-View Full Text K-Keyword Paragraph

H-Help BR-Browse Terms C-Change db MC-More commands
Full-Text Journal of Advertising

Yes, believe it or not, the Libraries are able to provide the
full-text for many of the documents in this database! Here
is a partial listing of some of the publications for which the
owners of the database have arranged for full-text access:

Age and Aging

American Journal of Psychology
British Journal of Political Science Change
Criticism

Economic Geography

Environmental Law

FDA Consumer

Foreign Policy

Futurist

Geriatrics

Human Rights Quarterly

Industrial and Labor Relations Review

Journal of Human Resources
Lancet

MacUser

Middle Eastern Studies
NEA Today

Observer

Public Welfare

Sciences

UNESCO Courier
Women’s studies

The exact composition of which journals are full-text and
which aren’t is not up the Libraries, but is determined by
contracts negotiated by the owner of the database. Ifa
particular article is available full-text, you can access this
once you have the bibliographic citation and abstract on
the screen by typing FT.
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Figure 2: List of General Commands in Academic Index - ACAD

Searching the database:

BR Browse terms
RE Use to revise your search statement

For Displaying your results:

D To display documents

For Managing your search process:

SO Sort Search results

Here are just a few of the important commands you will want to remember when using this database:

S Use when you want to enter a new search term

SC To get a full screen list of results - giving only the author and title for each

R Review the complete search history of your work during this session with the database
PG Purge previous searches (use to clear the screen and all previous work)

When you need Help:
H Help! General tips and ideas to help you see where you are at in the process and what your
options are
T A tutorial option to give you general search tips and guidance - a good place to start!

Where Can We Go Now?

How has the war in Bosnia affected American foreign
policy? Are there some recent articles on our own Gopher
and how it is being used. What trends are affecting interest
rates! Is diabetes sometimes caused by a virus? What is
known about the connection between dark, winter days
and depression?

Here is just a sampling of some of what I found doing
some quick search on the topics in the database:

Search Term No. of Articles Found
Bosnia and foreign policy 258
Gopher and Internet 39
Trends and interest rates 58
Diabetes and viral 11

Winter and depression 67

Give it a try yourself. Academic Index isn’t intended to

replace other, more specialized research tools, butitis a

very impressive, important, easy-to-use starting point for
whatever research question you might have,

If you have any questions or need help using this or any of
our databases, please feel free to stop in one of our campus
libraries or contact me, Nancy Herther, phone 624-2020;
Internet nherther@iic.lib.umn.edu.

My campus address is Integrated Information Center,
University Libraries, 6 Walter Library, East Bank.

-
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Using TIN

to Read USENET News

We’ve recently installed
a new Usenet
newsreader, Tin, on
the maroon and gold
E-mail hosts. Tin was
selected because it is an
casy-to-use newsreader
with a “look and feel”
that is similar to the Pine
mailer, Pico editor, and
Lynx Web browser
already on those ma-
chines. Tin features a full-screen
interface with lots of online help, and
you can even use some of the same
commands for navigating on screen
that you use in Pine.

Tin is a threaded newsreader, which
means that articles are displayed one
“thread” at a time. A threadisa
consecutive series of replies or articles
on a specific topic. These threads are
maintained and displayed in the order
that they are received.

On Screen Menus

Each screen in Tin has a menu of
commands at the bottom of the
screen. This menu lists only a few of
the most frequently used commands.
For a complete list of the commands
available from each screen, type h.
(The only screen or level of Tin where
this will not work is the initial
“newsgroup-checking” level.)

Quick Start Options

Tin provides simple commands to
help you get started quickly: i.c. the
-z option tells Tin to start only if
there are new or unread articles; the
-q option tells Tin not to check for
new newsgroups; and the -n option
tells Tin to display only groups listed
as subscribed to in your .newsrc file.

There is also a command to casily
download a newsgroup without
interactively accessing and saving
specific articles. The articles you’ve
saved can then be read later.

The .NEWSRC File

If you have used other news readers
on maroon or gold on a regular basis,
you probably have a “.newsrc” file
that contains information about the
newsgroups you are subscribed to and
which articles have been read. If so,
Tin will use the same .newsrc file, and
automatically display the groups to
which you are subscribed.

If you’ve never used a newsreader,
we’ve made getting started casy.
Since there are thousands of
newsgroups, with many new groups
added daily, it can take hours to view
all the groups and subscribe to the
ones you’re interested in. To avoid
this process and help new users get
started, our news administrators have
set up a “template” .newsrc file for
each account that automatically
subscribes you to a small list of
newsgroups that we recommend for
new users. Table 1 lists these groups.

Starting TIN

You can start Tin by simply selecting
it from the mail shell’s main menu as
you do to use Pine or Gopher.
However, you will first need to specify
Tin as your “preferred” newsreader,
since nn is currently the default news
reader.

To do this select Special Utilities, then
File Preferences, then Change News
Reader, then Tin. When you return
to the main menu, Tin should be
specified in the brackets after the
“Usenet News” menu item.

Table 1: Default .newsrc File

news.announce.important
news.announce.newusers
news.answers

news. lists

umn.config

umn.general.events
umn.general.food
umn.general.forsale
umn.general.housing
umn.general.jobs
umn.general.misc
umn.general.movies
umn.general.music
umn.general.sports
umn.local-lists.bookstore-prices
umn.local-lists.microcomputer-news
umn.local-lists.news
umn.news-server.announce
umn.news-server.questions
mn.general
clari.local.minnesota
clari.net.announce
clari.net.newusers J

Subscribing & Unsubscribing
You’ll use Tin’s initial “Group
Selection” menu to view and select
newsgroups you would like to sub-
scribe to. Type “y” and Tin displays
all unsubscribed newsgroups at the
bottom of the menu. Unsubscribed
groups are indicated with a U to the
left of the list. You can subscribe to a
group simply by moving your cursor
to the group and typing “s”. To

(13 ]

unsubscribe to a group, type “u”.

Selecting a Group

If you start Tin without specifying a
particular group, the “Group Selec-
tion” screen (Figure 1) will display a
list of active groups. Use your arrow
keys or the (J) and (K] keys to move
your cursor through the list line by
line, or move through the list page by
page using (Ctr)-D (down) and (Ctr}- U
(up). To view a particular group,
move your cursor to that group and

press (Return).
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Figure 1: Tin's “Group Selection Screen”

Group Selection (news.cis.umn.edu 42) h=help
1 124 alt.aldus.pagemaker Don’t use expensive user support
2 39 alt.ufo.reports Like alt.paranet.ufo,only dif
3 67 comp.internet.net-happenings Network announcements
4 188 rec.music.tori-amos Discussion of the singer
5 19 soc.history.living Living history and reenactment
6 alt.soc.comets
7 31 alt.tv.picket-fences The Picket Fences show.
8 6 umn.tc.systems systems announcements,discussion
9 1 comp.sys.mac.programmer.info Frequently requested information
10 16 rec.arts.books.reviews Book reviews. (Moderated)
11 64 rec.music.makers.bands For musicians who play in groups
<n>=set current to n, TAB=next unread, /=search pattern, c¢)atchup,
g)oto, j=line down, k=line up, h)elp, m)ove, q)uit, r=toggle all/unread,
s)ubscribe, S)ub pattern, u)nsubscribe, U)nsub pattern, y)ank in/out

Figure 2: List of Threads

alt.aldus.pagemaker (48T 92A OK OH R) h=help
1 + seeking employment advice Therese Maus
2 + PMS to HTML ? Shing-Te Li
3 + 2 comparing version Julie Clark
4 + Pagemaker 4.1/5.0 fony problem RavenGraph
5 +5 PM5.0 and Word 6.0 James Davis
6 + 2 graphics Saam Barrager
7 + 3 PageMaker to HTML file ? david s. broudy
8 + 4 Extracting text from Mac PMS Paolo G. Cordone
9 + New PageMaker 5.0 utilies for MAC? Sean M. Vadas
16 + 2 PM5 upgrade Richard S.Keirste
<n>=sget current to n, TAB=next unread, /=search pattern, "K)ill/select,
a)uthor search, c)atchup, j=line down, k=1line up, K=mark read, 1)ist thread,
I=pipe, m)ail, o=print, g)uit, r=toggle all/unread, s)ave, t)ag, w=post

Reading Articles of articles in the thread; the title of the Posting & Replying

After you've selected a group, a list of  first article in the thread, and the To post an article to the newsgroup,
threads will be displayed in the thread  author of that original article. use the “w” command. To follow-up
menu for that group (Figure 2). At a specific article, use the “f” com-

the top of the screen the group title is  Use your arrow keys or the (J)and (K)  mand.
displayed along with the number of keys to move through the list of
threads (e.g. 48T) and total number  threads, and select the one you wish

of articles (Cg 92A) in the group. to read by placing your cursor on it Other Options

_ and pressing (Retarn). Individual articles or entire threads
Each thread is represented by one line can be mailed using the “m” com-
which describes, from left tg right? While reading an article, press mand and saved using the “s” com-
ic thread number; a code indicating  to move to the next article in the mand.
if the thread has been read or not thread.

(“+” means it is unread); the number

-




Page 136

January 1995

Computer and...

Training Update: 625-1300

Distributed Comput-
ing Services owns
training packages for
many popular

software products.

We recently purchased
the packages listed below.

These training packages are available
to University of Minnesota depart-
ments and current employees and
students. There is no fee for using
these packages, and you may check
them out for 48 hours. However,
before you can check them out, you
must sign a Usage Agreement and
leave your University of Minnesota ID
with us. We will return your ID when
you return the training materials.

Reservations Required

To reserve or check out these materi-
als, phone 625-1300 or stop in our
Shepherd Labs office in room 190,
M-F, 8 am to 4 pm.

Unless you use our Self-Paced Train-
ing Centers, you must supply your
own equipment, such as computer
and cassette player, and software, such
as Microsoft Word or Windows, to
use these training materials.

Training Center Hours

Location Monday-Friday
1 Nicholson Hall 8 amto 7 pm
99 Coffey Hall 9 amto 4 pm
Macintosh

V¥ System 7.5
Audio training from Personal Training
Systems.

{0 Module 1, Basics: for the new user
who wants to learn to use the equipment
and operating system, start application
programs, get on-line help, and perform
tasks common to all applications.

[0 Module 2, Beyond Basics: learn to
understand the System Folder, create
aliases, open IBM-PC files, share files
using PowerTalk and AppleShare,
automate tasks with AppleScript.

V¥ Excel 5.0
Audio training from Personal Training
Systems.

J Module 1, Beginning: learmn to enter
words, numbers and percentages; create
formulas and functions; format numbers
and words; preview and print spread-
sheets; create and use templates.

] Module 2, intermediate: learn how to
auto-fill using custom lists; use styles
and create number formats; draw graphic
objects and create text boxes; sont lists
and modify outlines.

[0 Module 3, Advanced: create function
and 3-D formulas; use absolute refer-
ences and define named ranges, protect
and audit spreadsheets; use macros.

{J Module 4, Charts & Databases: create
and modify charts; use find and replace
command; use autofilter; extract records
from a database.

V¥ Word 6
Audio training from Personal Training
Systems.

0 Module 1, Beginning: leamn to enter
and edit text, create headers and footers,
check spelling and print documents;
change the appearance of text and set
tabs; use Wizards to create documents
quickly.

O Module 2, Intermediate: create tables;
add borders and shading; generate
automatically numbered lists; use styles
to format text quickly; use proofing tools
to proof documents.

[J Module 3, Advanced: use AutoFormat
and templates to quickly format entire
documents; create newspaper-style
columns; add graphics to documents;
use Word's Find File command and
sorting capabilities; generate form
letters.

Windows & Mac

V¥ Excel 5.0

We purchased a video training series
from MacAcademy/WindowsArcade. The
topics covered in each tape are the same
whether you use Windows on an IBM-
compatible or use a Macintosh.

0 Tape 1: learn about installation,
workbook, cells, tabs, worksheets,
function tool, formulas, templates,
relative mode, paste special, absolute
reference, auto fill, tool menu, tool bar,
tip wizard, RAM memory, password, file
types, summary info, page setup,
printing, headers /footers, print page
order, shortcuts.

J Tape 2: learn about names, calcula-
tion, functions, function wizard, rows,
delete/insent, spelling checker, tools,
name definitions, sorting, clear, move/
copy, find, find/replace, tool bar, view
manager, page break, notes, format
cells, column width, custom format,
date/time, update function, time frames.

[ Tape 3: leamn text alighment, borders,
patterns/colors, quick data path, protect
document, rename sheet, auto format,
style, tools menu, circular references,
payment calculations, goal seek, daisy
chain calculation, page setup, RICI
notations, numbered worksheets, colors,
hiding, edit titles, logic statements, profit
worksheets, error messages.

J Tape 4: learn about checkbook, cell
protection, logic statement, linking,
rename, re-establishing links, change
links, arrays, complex link, database,
extract information, wild card, P&L
statement, outline, tables, sont, subto-
tals, filter, charts, format data series.

(0 Tape 5: learn about charts, hot spots,
drawing tools, text, group, macros, visual
basic, run macros, alert command, debug
macro, payment macro, custom tool
bars, custom tools, buttons, function
macro, dialog editor, custom menu.

-




Computer Facilities: Winter Quarter 1995

January 3 to March 18, 1995. Most facilities will be closed for the Martin Luther King Holiday (January 16).

Building Room Phone Classes Hours: Weekday Hours: Weekend Notes
East Bank Preliminary
Schedule

O Students have free access to these microcomputer facilities.

V¥ Microcomputer facilities managed by Distributed Computing Services: contact Jerry Larson at 625-7850.

Eddy Hall Annex 54 6250314 M-Th * Sat * *To reopen soon.
Fri * Sun *

Elliott Hall 121 624-0866 t M-Th 9 am-8 pm closed
Fri 9 am-5 pm

Foiwell Hall 14 625-4896 T M-Th 8 am-10 pm Sat 10 am-6 pm
Fri 8 am-6 pm Sun 4 pm-10 pm

Lind Hall 26 626-0856 t M-Th 8 am-midnight Sat 10 am-6 pm
Fri 8 am-6 pm Sun  noon-midnight

Watch for 24-hour schedule to be posted the 6th week of each quarter.

Walter Library 9 626-1899 1 M-Th 8 am-midnight Sat 10 am-6 pm

Fri 8 am-8 pm Sun  noon-midnight

WV Microcomputer facilities managed by other departments.

Moos Tower 8425 — M-Th 8 am-5:30 pm closed
Contact: Gail Vandermerwe, 625-1477 Fri 8 am—4:30 pm

O IT Computer Facilities for IT students only.

* For eligibility and fee details see the Institute of Technology Computer Facilities brochure.
¢ Problems? Report to lab attendant. Report unanswered questions to operator@itsparc.itlabs.umn.edu

EE/CSci 3166 624-8885 M-Th 7 am-2 am Fri Sat 10 am-2 am Sun
Fri 7 am-midnight Sun 10 am-2 am Mon
EE/CSci 4204 6259081 M-Th 7 am-2 am Fri Sat 10 am-2 am Sun
Fri 7 am-midnight Sun 10 am-2 am Mon
Mech. Eng. 308 6257352 M-Th 7 am-2 am Fri Sat 10 am-2 am Sun
Fri 7 am-midnight Sun 10 am-2 am Mon
Physics 130 625-6820 T M-Th 8 am-10 pm Sat 10 am-6 pm
Fri 8 am-6 pm Sun 4 pm-10 pm

[J Students have free access to these terminal facilities.

Diehl Hall 278 — limited access limited access
Contact: 626-4045
Nicholson 1 625-5082 M-F 8 am-6 pm closed

Contact: Mike Dunham, 625-7397
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Computer Facilities: Winter Quarter 1995

January 3 to March 18, 1995. Most facilities will be closed for the Martin Luther King Holiday (January 16).

Building Room Phone Classes Hours: Weekday Hours: Weekend Notes
West Bank Preliminary
Schedule
] Students have free access to these microcomputer facilities.
¥ Microcomputer facilities managed by Distributed Computing Services: contact Shu-Fan DeJarlais at 624-0877.
H. Humphrey Ctr 50 624-6526 M-Th 8 am-midnight Sat 10 am-8 pm
Fri 8 am-10 pm Sun  noon-11:30 pm
W Microcomputer facilities managed by Distributed Computing Services: contact Jamil Jabr at 624-7766.
Blegen Hall ¢ 455 626-7778 t M-Th 8 am-10 pm Sat 10 am-6 pm
Fri 8 am-6 pm Sun noon-5 pm
St. Paul
] Students have free access to these microcomputer facilities.
W Microcomputer facilities managed by Distributed Computing Setvices: contact Jamil Jabr at 624-7766.
Central Library B50 624-3269 T M-Th 8 am-10 pm Sat 10:30 am—4:30 pm
Fri 8 am—-6 pm Sun 4 pm-10 pm
Classroom Office Bldg. 135 624-9226 T M-Th 8 am-10 pm Sat 10 am-6 pm
Fri 8 am-6 pm Sun 4 pm-10 pm
Classroom Office Bidg. 17 626-1252 T M-Th 8 am-midnight Sat 10 am-6 pm
Fri 8 am-6 pm Sun  noon-midnight
McNeal Hall & 305 624-5367 t M-Th 8 am-midnight Sat 10 am-6 pm
Fri 8 am-6 pm Sun  noon—-midnight
WV Microcomputer facilities managed by other departments.
Vet. Science 450 624-4281 M-Th 8 am-9:30 pm Sat 9 am-5 pm
Contact: Livija Carison, 624-3078 Fri 8 am-5 pm Sun 1 pm-9 pm
Printing is Not Free Misc. Notes Internet and CIS network .
A Printer Access Card is required to 1 Instructors can reserve these labs for Through the Computer and Information
obtain output in all microcomputer instructional use; contact the depart- Services network, these Computer
facilities and laser or plotter output in ment responsible for the lab. Facilities can access the Internet,
IT Computer Facilities. LUMINA, E-mail, and other Central
# These labs are frequently scheduled System computers, e.g., EPX, NVE'f
Central Systems printing is charged for classroom use. Call before UZ, VX, VZ, VM1, and the School 0
against Central Systems accounts. making plans to use these facilities. Management’s |BM mainframe.
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Free Help: Computing and Information Technologies

Phone Help Line Hours

Central Systems

These systems require a user name and password, which you get when you open an account.
Qualified users can apply for grants to cover some computing related costs.

0O EPX (Unix), NVE (NOS/VE), UZ (Ultrix), VX and VZ (VMS)

..................... 626-8366 ...... M—F ...... 9 am to 4 pm

0 VM1 (IBM/CMS) 99B Coffey Hall walk-in consulting hours may vary.... 624-6235 ...... M—F ...... 9-11 am, 2-4 pm

[0 MEDLINE (MinnesotaMEDLINE on NVE).........cccoeeeeeennnnnnn.

..................... 626-8366 ...... M—F...... 9am to 4 pm

Distributed Systems: Microcomputers, Workstations, LANs

Software, hardware, peripherals, local area networks ...........

O East Bank ......... 152 Shepherd Labs ...........cceevvvueeeee.
[0 West Bank ........ 93 Blegen.....cccoivvvieeieiecee e,
J st. Paul ............ 58 Biological Sciences Center ............

E-mail and LUMINA

(O E-mail: call for help using your University account.........

...................... 626-4276 ...... M—F ...... 9 am to 4 pm

...................... above............. above..... above

...................... above............. above ..... 1 pm to 4 pm
...................... above............. above..... 1 pmto 4 pm
...................... 626-7676 ....... M—F ...... 9amto 4 pm

Forgot your password? Staff: call 626-8366. Students: go to any Computer Facility — e.g., 14 Folwell, 26 Lind,
305 McNeal, HHH 50. Troubleshooting: if Maroon or Gold are down, you'll hear a status report at 626-1819.

[J LUMINA: call if you have trouble connecting ..................

Computer Services INformation...........ccevveeivvieiiiiinicicriineneennn,

..................... 626-7676 ....... M—F ...... 9 am to 4 pm

....................... 625-1555 ...... any day .. any time

General Information

Williamson Hall Book Center
Computer Dept ... 625-3854

(inventory and prices also available on Internet Gopher)

University Computing and Information Services
Administrative Information Svcs. (AlS) Help desk ...4-0555

Biomedical Graphics, various locations .................. 6-3939
Central Computing Services, 100 LaudCF............... 6-1600
Accounts: EPX, NVE (incl MEDLINE), UZ, VX, VZ..6-8366
Data Entry ...cooeeveiiiiiiiiirieccierr e 6-8351
Statistics ServiCes ...ooivvrriiiiieeiriieiccrere e eceeaaes 5-2303
System StatuS ..o e 6-1819
Tape Librarian .......c...cccovveeceeiiiimeeeiceerreecccrereesenens 6-1838

Computer Facilities (also call individual facilities) .. 5-1300
_FolH5-4896 _Lind 6-0856 _McN4-5367 _HHH 4-6526 +more

Disability and Computing Services, voice/TTY ........ 6-0365
Distributed Computing Services, 190 Shep Labs....5-1300
Engineering Services, 103 LaudCF ..............cceuueeeee. 5-1595
Equipment Repair and Warranties ...........cccuu...... 5-1595
Faculty Resource Center (for appointment) ............. 5-1300
Gopher Hotel (server set up for a fee) .......cceuueueee... 5-2303
Kodak Printer Service .......cccccvvuveevireiiieceeeiriiennnen, 6-1661
St. Paul Computing Services, 50 CofH........c.cue...... 4-7788
Accounts: VM1 (IBM/CMS) ....ccocovuveeerrniiriiieeennn, 4-7788
Tape Librarian ......ccccceeevvieeveieeeeiiiieeieeeiee 4-3482
Statistics Services .......cocvveevereeiiieiiiiieeeieeeene 4-6235
Software Services (contract programming).............. 5-2303
Supercomputer Center Help, 3030 SCC ................. 6-0808
Telecommunications, 30 TelecomB
Networking Services Information ........................ 6-7800
Networking Services Repair ..........ccceeeveevveeveerennn 5-0006
Training, Course Registration, 190 SheplLab .......... 5-1300
U Libraries, Integrated Information Center.............. 4-2020
University Networking Services, 130 Lind ............... 5-8888

Associate Vice President and

Associate Provost Academic Affairs
Donald R. Riley, Professor..........cccoceeeevvvon.. 626-9816

Access Information

SLIP: 2400/14,400
SLIP: ADI-100 and ITE (with MKO)

626-1920
3-0291

a Terminal settings for O Internet addresses.
these systems are 8-1-N [ Dial-in Server: 626-0300,
(8 data bits, 1 stop bit, -1200, -2400, -4800, -9600
no parity) unless other-
wise noted. The number = :L 96::;\'7 Iggoa:?‘g‘ MNP
you dial may depend on pp ’ .
level 5 error correction.

the modem'’s bps or
0 On campus ADI-100 and

baud rate.
ITE setups use 626-2400.
LUMINA: 300/1200/2400 ......ceeveervnevrvnnnnn 625-6009
[ R 7 U 4-7539

a

()

Telnet & tn3270 PUBINFO.AIS.UMN.EDU O
E-mail and Internet Service and Servers, Twin Cities

GOLD.TC.UMN.EDU O

O

a

O

MAROON.TC.UMN. EDU
Gopher, alternate access (log in as gopher)
300, 1200, 2400, 9600 ............ see Dialin Server
CONSULTANT.MICRO.UMN. EDU
Consulting via E-mail: low priority Central System ques

Format __ CONSULT@MACHINE.NAME.UMN.EDU
AlIS SecurelD V.32 .....cceiiveieivireieneicensenesnns 626-1061 Q3

300/1200/2400 .....couunieeniiirieieeereerireeeeeenns 67770 @

tn3270 & Telnet ADMIN.AIS.UMN.EDU O
EPX, NVE (includes MEDLINE), UZ, VX, VZ

300, 1200, 2400, 9600 ............ see Dial-in Server

EPX or UZ or VX or VZ or NVE.CIS.UMN.EDU QO
EPX, NVE: 300/1200/2400 .....cocceveereen.n. 625-1445 @

up to 19.2 campus data phone .................. 32400 @
VM1 (IBM/CMS) at 7-1-even

=110 T SO 624-3668

1200/2400 & <19.2 campus data phone ..4-4220 =

VM1.SPCS.UMN.EDU O

Trademarks: Internet Gopher and POPmail are registered trademarks of the University of Minnesota.
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